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Important Safety Information 
 

Symbols (Symbole) 
 

This symbol identifies information about procedures, practices or 
conditions that can result in damage to the product, economic loss, 
personal injury, or death. 
(Dieses Symbol kennzeichnet Hinweise zu Handlungsweisen, 
Methoden oder Zuständen die zu Schäden am Produkt, 
wirtschftlichem Verlußt, Personenschäden oder zum Tode führen 
können.) 

 
This symbol identifies information about practices or circumstances 
that may lead to damage to the product or other economic loss. 
(Dieses Symbol kennzeichnet Hinweise zu Handlungsweisen oder 
Sachverhalten die zu Schäden am Produkt oder anderen 
wirtschaftlichen Schäden führen können.) 

 
This symbol identifies where there may be risk of damage to the 
product due to Electrostatic Discharge. 
(Dieses Symbol kennzeichnet Stellen an denen das Produkt durch 
elektrostatische Entladung beschädigt werden könnte.) 
 

 
 
 

This symbol identifies information that is essential to the 
understanding and correct use of this product. 
(Dieses Symbol kennzeichnet, für das Verständnis und den richtigen 
Umgang mit dem Gerät, wesentliche Hinweise.) 
 
 

Warnings (Warnung) 
 

All moving parts are interlocked to the printer lid. The machine will 
stop if the lid is lifted during operation. 
(Alle beweglichen Teile sind mit der Drucker Klappe gekoppelt. Die 
Maschine bleibt stehen wenn die Klappe im Betrieb geöffnet wird.) 

 
 
 
 
 
 
 
 
 
 

IMPORTANT 

ESD Advisory 
ESD = Electrostatic Sensitive Device    
(EGB = elektrostatisch gefährdetes Bauteil)

IMPORTANT 
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Safety (Sicherheit) 
 

Only qualified, service-trained personnel who are aware of the 
hazards involved should perform calibration, maintenance, or repair 
of the product. Only these qualified personnel should remove the 
covers from the product. 
(Kalibrierungen, Wartungen oder Reparaturen am Produkt sollten nur 
von qualifiziertem Servicepersonal, das sich den bestehenden 
Gefahren bewusst ist, vorgenommen werden. Nur qualifizierte 
Servicepersonal sollte die Abdeckungen am Produkt entfernen.) 
 
For continued protection against fire, replace the line fuses only with 
fuses of the specified type and rating. 
(Ersetzen Sie die Eingangssicherung nur mit Sicherungen des 
spezifizierten Typs und der spezifizierten Leistung, um einen 
sicheren Betrieb zu gewährleisten und Bränden vorzubeugen.) 
 
Modification or misuse of the product or components can cause harm 
to the user and will void any warranty. 
(Veränderungen oder Missbrauch des Produkts, oder 
Veränderungen oder Missbrauch von Komponenten können den 
Benutzer oder Dritte schädigen und führen zum Garantieverlußt.) 

 
The product must be connected to a protective earth conductor via 
the three-wire power cable. The power plug shall be inserted only 
into a grounded outlet. Do not defeat the protective action by using 
an extension cord without a grounded conductor. 
(Das Produkt muß durch den Betrieb mit einem dreiadrigen 
Stromkabel geerdet werden. Der Stecker darf nur in eine geerdete 
Steckdose gesteckt werden. Benutzten sie nur dreiadrige 
Verlängerungskabel mit Erdung.) 
 
Fluid used in this product must have a fire point greater than 125° C. 
(Flussigkeiten die in diesem Produkt eingesetzt werden müssen 
einen Flammpunkt grösser 125°C haben.) 

  
Do not operate the product in an explosive atmosphere. Do not 
operate the product in the presence of inflammable gases or fumes. 
Operation of any electrical instrument in such an environment clearly 
constitutes a safety hazard. 
(Benutzten sie das Gerät nicht in explosiver Atmosphäre. Benutzen 
sie das Gerät nicht in der Nähe von entflammbaren Gasen oder 
Dämpfen. Der Einsatz jeglicher elektronischer Geräte in einer 
solchen Umgebung stellt eine eindeutige Sicherheitsgefährdung dar.) 
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Care must be used when jetting multiple fluids. It may be possible for 
reactions to occur in the absorbent pads where multiple and or 
incompatible fluids may come in contact with each other. 
(Vorsicht ist beim Umgang und Druck mehrerer verschiedener 
Flüssigkeiten geboten. Es ist möglich, dass Reaktionen in den 
Absorberkissen stattfinden, wo inkompatible Flüssigkeiten 
miteinander in Kontakt geraten können.) 
 
The platen can reach temperatures of 60° C which is hot to the 
touch. It can melt some materials if placed on it while hot, and it can 
cause volatile materials to evaporate faster if placed on the platen 
when hot. 
(Die Substratplatte kann Temperaturen von bis zu 60°C erreichen. 
Dies ist zu heiss, um sie zu berühren. Diese Temperatur kann 
Materialien zum schmelzen bringen, wenn diese auf die Platte 
gestellt werden. Ausserdem verdampfen flüchtige Materialien 
schneller wenn sie auf die heisse Platte gestellt werden.) 
 
The cartridge can reach temperatures of 70°C which is hot to the 
touch, and it can cause volatile materials to boil off faster. Care must 
be taken that the cartridge settings are appropriate when installing a 
cartridge with volatile fluids. 
(Das Cartridge kann Temperaturen von bis zu 70°C erreichen. Dies 
ist zu heiss, um es zu berühren. Ausserdem verdampfen flüchtige 
Materialien schneller wenn sie das heisse Cartridge berühren. Die 
Cartridge Einstellungen müssen sehr sorgfältig gewählt werden, 
wenn mit leicht flüchtigen Materialien im Cartridge gearbeitet wird.) 

 
Replaceable pads capture and hold virtually all ink jetted into them. 
In many cases this may then be considered “solid waste” rather than 
“liquid waste.” Please dispose of properly. 
(Die austauschbaren Absorberkissen können fast alle Tinten 
aufnehmen. In vielen Fällen gilt dies ehr als „Fester Abfall“ und nicht 
als „Flüssigkeits Abfall“. Bitte entsorgen sie diesen fachgerecht.) 

 
This product complies with INSTALLATION CATEGORY II and 
POLLUTION DEGREE 2 in IEC61010-1. This product is an INDOOR 
USE product. 
(Dieses Produkt erfüllt die Forderungen der „Installation Category II“ 
und „Pollution Degree 2“ nach IEC61010-1. Dieses Produkt ist ein 
Produkt für den Gebrauch in trockenen Räumen.) 

 
The LEDs within this product are Class 1 in accordance with 
IEC60825-1, CLASS 1 LED PRODUCT. 
(Die LEDs in diesem Produkt sind Class 1 nach IEC60825-1, Class 1 
LED Product.) 
 

IMPORTANT 

IMPORTANT 

IMPORTANT 
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Note: This equipment has been tested and complies with the limits for a Class A digital 

device, pursuant to part 15 of the FCC Rules. These limits are designed to provide 

reasonable protection against harmful interference when the equipment is operated in a 

commercial environment. This equipment generates, uses, and can radiate radio 

frequency energy and, if not installed and used in accordance with the instruction manual, 

may cause harmful interference to radio communications. Operation of this equipment in 

a residential area is likely to cause harmful interference in which case the user will be 

required to correct the interference at one’s own expense. 

 

This product complies with the radio interference requirements of the European Union. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

Do not dispose this product as unsorted municipal waste. Collection 
of such waste separately for special treatment is necessary.   
(Entsorgen sie dieses Produkt nicht als unsortierten Hausmüll. Eine 
fachgerechte Entsorgung ist nötig.) 

. 
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System Description 
The Dimatix Materials Printer, or DMP, is a laboratory and limited production tool that 

enables researchers, scientists, and engineers to evaluate the use of ink jetting 

technology for new manufacturing and analytical processes. It is designed to be 

convenient and easy to use to carry out “proof of concept” and development work using 

ink jet technology. It does have extensive capabilities to allow increased experimental 

sophistication to optimize process parameters for the user’s applications as the user 

gains familiarity with the system. 

 
• Sheet substrate scanning “ink jet” deposition system with drop observation, spot 

location, and variable printing resolution 

• Low cost, user-fillable piezo-based jetting cartridges: 

o Fluid module with syringe filling system 

o 16 nozzles at 254 µm spacing 

o 10 picoliter drop size with multi-burst capability 

• PC-controlled operation, including visual monitoring of ink jetting and printed 

pattern inspection 

 
System Accessories 

 
• Personal Computer (supplied) 

o 2.4 GHz CPU minimum 

o Two available USB 2.0 ports on computer (shows up as "Standard 

Enhanced PCI to USB Host Controller" in device manager). 1280 x 1024 

screen resolution 

o 512 MB dram minimum 

o At least 200 MB free disk space 

o Windows XP operating system with Service Pack 2 installed 

• Starter Kit – consists of (1) DMC-11610 cartridge, (1) 30 ml bottle of model 

fluid, (1) fill tip, (10) cleaning pads, (1) drop watcher pad, (1) filter and (1) 

syringe  

• Syringes 

• Filters 

• Fill tips 
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• Drop watcher pads 

• Cleaning pads 

• Substrate location and positioning system (fiducial camera system) 

 
System Requirements 

 
• Power: 100-120 / 200-240 VAC 50/60Hz 375W maximum 

• Environment: It is recommended that the DMP be used in a reasonably 

controlled temperature and humidity environment to aid in uniform test results. 

Atmospheric conditions can affect the materials used in jetting trials. 
o Operating: 

- Temperature range 15 to 40°C 

- Humidity range 5-95% RH, non-condensing 
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System Identification 
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Set-Up and Installation 

Unpacking 
DMP 

• The DMP is shipped in a wood crate 

• The DMP weighs approximately 45 kg (100 lbs). It is required that a minimum 

of two people lift it out of the crate and place it onto a surface sturdy enough to 

support it without excessive vibrations or oscillations. *Be careful not to put 

fingers into fan covers on the DMP bottom when lifting. 

• Remove items from box 

o Starter Kit 

o Cartridges 

o User Manual 

o Cables 

 
• Verify contents with checklist 

• Place DMP on an appropriate surface 

• Remove shrink wrap from DMP 

• Free items that have been secured for shipping 

 
1. Remove foam under carriage assembly 

2. Remove foam from front and side of platen 
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PC 

• The PC system is shipped in its original boxes 

• Remove them from their boxes and set them next to the DMP 

 
• Check back of the DMP for USB, S-video, and power connections. Identify 

appropriate cables. 

• Connect all cables 

o Power cables to DMP, PC and monitor 

o USB cable from PC to DMP 

o S-video cable from DMP to PC 

o Monitor video cable to PC 

o Keyboard and mouse cables 
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• Turn on power to PC 

o Allow PC to go through complete start up 

• Note: Do not change the Regional Settings in the Windows XP Operating 

System. The software will not operate properly. Do not connect DMP to PC 

through a USB hub. Do not use video or USB cables longer than 2 meters. 

Note the air flow pattern if you need to consider ventilation. 

 

Starting Your DMP 
• Make sure DMP lid is closed and all shipping foam is removed 

• Turn on power to DMP 

o The light next to the power switch should go on 

                                 
o Wait at least 5 seconds 
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Run Application 

• The DMP 2800 icon is on the PC desktop. Select the DMP 2800 icon on the 
screen. 

                                                         
                                          Dimatix Drop Manager 
 

• Double click to initiate the Dimatix Drop Manager application. 

• After initiating the program, click OK to allow the DMP to run through its 

initialization sequence. 

 
 

Start-Up Operation 

Screen Descriptions 
The following screen Printer Configuration Information can be located in the Help tab 

on the Dimatix Drop Manager (DDM) window. It provides information regarding the 

version on the DMP, its software, as well as actual cartridge and platen temperature and 

nozzle meniscus pressure. This information is helpful later if you want to verify those 

parameters during operation of the DMP. 
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The information in the following image is only for example purposes and may not match 

the information for your DMP. 

 

 
 

 
An additional program feature is a link to the FUJIFILM Dimatix Web site. If your PC is 

connected to the internet, click on the Dimatix logo on the bottom right of the various 

DDM screens to automatically connect to the Web site. 
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Install Cartridge 

 
• Prepare the Dimatix Model Fluid Cartridge from the Starter Kit. See Cartridge 

Filling instructions. 

• Lift the DMP lid all the way open. 
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• Insert the cartridge into the cartridge holder on the carriage with the electrical 

connection pads towards the back of the machine matching the connector of the 

holder. There is only one way it will fit. Push it down firmly so that it “clicks” into 

place. 

• Pull the cartridge holder latch forward and down until it locks in place. You will hear 

a click. Check to see that the cartridge is sitting flat in the holder. 
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• After the cartridge is installed, close the lid. You should hear a pump turn on to 

control the meniscus pressure. 

• The following window will pop-up. 

 

 
 

 

• Click Yes to load the settings for Dimatix Model Fluid 2. 

• After clicking Yes, the screen will advance to the Select Pattern Screen. 
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Select Pattern 

 

 
• The Dimatix test pattern will be auto-selected. This is a general use pattern which 

will let you see that the system is operating correctly.  

• Click on the Next button to proceed. 

• This takes you to the Load/Unload substrate screen. 
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Load/Unload Substrate  

 
 

• On this screen you control the platen temperature and vacuum. You also must 

enter the thickness of the substrate you are going to use. To start, use the 

enclosed piece of glossy ink jet paper to run the test pattern. This paper is about 

250 micrometers thick. Enter 250 (µm) in the box either by using the up or down 

arrows on the box or placing the cursor in the box and typing in the number. The 

system automatically adjusts the height of the cartridge to about 1.0 mm above the 

substrate. Be sure that you enter the correct thickness. Entering a number that 

is smaller than the actual thickness may cause the carriage to crash into or drag 

across the substrate.  

• Open the lid and place the substrate on the platen. Register it to the marks in the 

back left corner of the platen which is a general substrate registration position. This 

is important to note since it will be the approximate location from which the 

patterns to be jetted will be referenced initially. 
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• After placing the substrate on the platen, turn on the platen vacuum by selecting 

the Vacuum On button. If your substrate is not very flat, stiff, or smaller than the 

platen you may need to cover some of the open vacuum holes with some mylar, 

adhesive tape, or other material to direct more vacuum to your substrate. 

• If you want to heat the platen, you can enter the temperature in the box by typing 

or using the arrows. The system will not print until the platen reaches the desired 

temperature. This may take up to 20 minutes for a setting of 60°C. By clicking on 

the down arrow on the box you will get to a line in the box which represents a 

setting of “no- temperature.” The platen will then run at ambient temperature. 

• You are now ready to go to the next step Print Set-Up by clicking the Next button. 

Print Set-Up 

 

• Now you are finally ready to start jetting. The Pattern has been selected, the 

Substrate Settings have been entered, and the Cartridge Settings have been 

entered. 
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• Click on the Print button and the Print Preview window will open. This window 

shows where the print origin is on the platen, where the image to be printed is and 

the number of nozzles used to print. 

 
• Click on the Print button and the pattern will be printed. Your DMP will jet the test 

pattern. 

 

Advanced Uses 
Now that you have successfully been through a sequence to make a print, you can learn 

more details that you may need to jet your fluid. 

 

Cartridge Settings 
In the start up procedure we showed how to select a file with a specific Cartridge Setting 

that had been predetermined for the test fluid by FUJIFILM Dimatix. Now we will get into 

the details of the settings and the editor screens. 
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You can view Advanced Cartridge settings using the Tools menu Enable Advanced 
Features. Additional parameters are added to the cartridge settings: 

By clicking on the Edit button on the Cartridge Settings box, the following screen comes 

up. 

 
On the above window you can select a previously created waveform in the File list. You 

can adjust the voltage to each jet nozzle individually by typing a number in the individual 

nozzle box or by clicking on the up or down arrow in the nozzle box. You may want to do 

this to adjust drop velocities of individual nozzles, since velocity is a function of voltage. 

You can also change all of them simultaneously with the Adjust All arrows. (See 

Wavefrom Editor for effects of voltage on jetting). The Increment number is the amount 

the voltage will change with one click on the up or down arrow buttons. 

 
Note: Once you have established the settings for a particular fluid, you may have to 

adjust the voltages for a new cartridge to match the drop velocity of a previous cartridge. 

See Drop Watcher for instructions on setting drop velocity. 
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Note: Tickle control can only be accessed by opening the cartridge settings of the print 

setup screen in the DMP main program. Opening the cartridge setting via the Drop 
Watcher will not allow you to change tickle control as it will be displayed in gray. 

If you click on the next tab on the window Cartridge, the following screen comes up. 

 
This screen allows you to set the temperature of the cartridge. This is usually used when 

the fluid is too viscous to jet and you need to lower the viscosity by raising the 

temperature to get the desired jetting performance. 
 

Also on this window is the setting for Meniscus Vacuum. Ink jetting devices operate 

under negative pressure to keep the meniscus at the edge of the nozzle. You may need 

to adjust this depending on the viscosity and surface tension of your fluid. Four inches of 

water is a typical value. Having the correct Meniscus Vacuum level usually affects the 

high frequency performance of the fluid you are jetting. 
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The Tickle Control enables and controls low amplitude pulse that is given to the nozzle 

periodically simply to move the meniscus slightly but not fire a drop. This is to help keep 

the nozzle from “skinning over” with a thin layer of material left from fluid evaporating. The 

“tickle” function is completely adjustable, and is very important for some fluids and not 

required for others. 

 

The low amplitude pulse that tickle control sends to the nozzle can be modified in the 

waver form editor window as the non-jetting waveform. The frequency set in tickle control 

is always active when the printer is not printing. This includes the times during which the 

carriage is above the maintenance pad, on its way to the selected print area or on its way 

back from one print pass to start the next pass. However, during printing, the tickle 

frequency is the same as the firing frequency set in the wave form editor. So during one 

print job, the printer repeatedly switches between the two pulses. 
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The Cartridge tab’s Jets to Use function allows you to select only the range of nozzles 

you wish to use to jet your pattern, if you want to use fewer than all sixteen. The software 

will automatically compensate for the # of nozzles used but the nozzles selected can only 

be one series of adjacent nozzles. 

 

The Cartridge Print Height sets the distance of the printhead above the substrate during 

printing. It can be adjusted from .25 mm to 1.5 mm. Take care to set the substrate 

thickness and Cartridge Print Height accurately to avoid hitting the substrate during 

printing. 
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The Cleaning Cycles tab let you control how the print cartridge is cleaned before, during, 

and after printing. Some fluids do not need periodic maintenance, while others need a 

high amount of maintenance to keep nozzles clear and functioning properly.  

• The Select button lets you select an existing cycle in the cleaning cycle folder. 

• The Edit button lets you edit that cycle with the editor window. 

• Start of Printing refers to the cleaning you want to do at the beginning of the print. 

Select a cycle you wish to run to enter one in that box or you can edit an existing 

file with the edit button.  

• During Printing refers to the cleaning cycle you want to run while printing your 

pattern. This can be set to run every so many number of bands (one cycle of the 

carriage across the platen and back is a band) or every so many seconds of 

printing time. Select a cycle you wish to run by clicking on Select and choose one 

from the folder or you can edit an existing one with the Edit button. Whichever is 
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more frequent between Run every x bands Or Seconds (depending on printing 

speed) is the cycle that will be used During Printing. 

• End of Printing refers to the cleaning you would like to do at the end of your 

printing. Select a cycle you wish to run to enter one in that box or you can edit with 

the edit button. 

• While Idle refers to any cleaning you would like to do while the system is not 

printing but is on and you have a cartridge installed. Select a cycle you wish to run 

to enter one in that box or you can edit with the edit button. 

• None can be entered into any box that would have a file name to indicate not to do 

any cleaning during that time. 

• 0 can be entered where numbers are required to indicate not to run that cycle. 

Cleaning Cycle Editor 
The Cleaning Cycle Editor can be run by clicking the Edit button by any of the cleaning 

cycles or by selecting Cleaning Cycle Editor from the Tools menu. From this editor you 

can create sequences of operations that can be saved as a cleaning cycle file. Refer to 

the Cartridge maintenance section in the back of the manual for more details. The default 

cleaning cycle, Spit Purge Spit, is shown below: 

 

 
• Spit refers to firing the nozzles for the designated time and frequency. 
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• Purge refers to pushing fluid out through the jetting device with pressure (system 

is preset to 5psi). This process is usually used to get air out of the jetting device. 

• Blot refers to the cartridge simply coming down and making contact with the 

cleaning pad for the designated time. * Note: It is important to make sure that the 

cleaning pad is not saturated or clogged to ensure good removal of the fluid from 

the nozzles after purging or spitting. 

• The Delay time is the time after the cleaning before going to the next step in the 

cycle. 

 

A cleaning cycle can be very simple, such as a “2 second blot” or they can consist of 

several combinations of actions (spitting, purging, and blotting) with varying times.  

 

Here is how to create a Cleaning Cycle: 

• Click on the Spit, Purge, or Blot. 

• Then enter a number or use the arrows for the Time, Frequency or Post 
Delay that you want.  

• Click the Add button and that will enter it into the table and incorporate it 

into the cycle.  

• If you want another action to occur next, simply repeat the process.  

• If you want to delete a step, highlight it in the table by clicking on it, then 

click the Delete button. 

• When you have built your cleaning cycle, save it (by going to File-Save As) 

with a name that describes what it does. That way you can easily identify it 

in the folder in the future. 
 

If desired you can run the Cleaning Cycle you just created by clicking on the Run Now 

button. 

 

Also under the Tools option in the Cartridge Settings window you will find the 

Waveform Editor. Click on the Waveform Editor. 
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Waveform Editor 

 
This is the most powerful screen in the control software regarding jetting fluids. On this 

screen you control the shape of the pulse to the nozzle to eject a drop. To adjust a 

segment, simply point your arrow to it and click on it. The selected segment will change 

from blue to red. 

 

Individual Segment Controls: 
In this box you have several parameters at your control. When you want to modify a 

segment you click on that segment on the graph with the mouse to highlight it. Then you 

can modify the parameters for it by typing in a number, using the up/down arrows or slider 

bar. 

Level – This is the percent of the amplitude relative to the value you have in the 

Cartridge Settings: Waveform screen. 

 Slew Rate – This is the slope of the line in the waveform during voltage ramps. 

 Duration – This is the length (time) of the segment. 

You can add a waveform segment to optimize drop ejection by clicking on the segment 

that you want to place a new segment in front of and click the Add button. You can now 
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modify that segment as you would the others. You can delete a segment simply by 

clicking on it and selecting the Delete button. 

 

Overall Waveform Controls 
Duration Scaler – This feature allows the user to easily scale the entire waveform pulse 

width at once. This is useful when you are using fluids with different densities. Higher 

densities generally need longer pulses. Enter a number in the box then click the Rescale 
Waveform button. The entire waveform’s width will change by multiplying its current 

width by the Rescale number. For example, if you enter 1.1 in the Duration Scalar box, it 

will adjust each waveform segment’s length proportionally to multiply the waveform’s 

overall width by 1.1, which is a 10% increase.  

Width – This box displays the overall pulse time width for the entire waveform. 

Maximum Jetting Frequency – This is a number the user can enter to prevent the DMP 

from jetting the fluid at a frequency higher than that which may have been determined as 

the upper stability limit through drop watching. It also sets the scale for the Firing 

Frequency Maximum in the Drop Watcher.  

Note: The DMP will always try to print with a carriage speed of 300mm/sec unless it is 

Maximum Jetting Frequency limited. 

 

Non-Jetting Waveform 
The Non-Jetting Waveform can be modified by clicking on an individual segment and 

moving it. The instructions are in the box to the right of the graph. 

 

Jetting Waveform vs. Non-Jetting Waveform 
When the printhead travels over the print area, the software automatically tells it which 

nozzles to fire and which are idle. The idle nozzles still get a small amplitude signal 

transmitted to them. This is the Non-Jetting Waveform. The firing nozzles get addressed 

with the Jetting Wave Form.  

 

The Non-Jetting Wave Form is also the pulse signal that the Tickle Control sends to 

the printhead during non-printing times when the carriage is above the maintenance pad, 

or when it is moving to the defined print area or moving between two print passes. This 

keeps the fluid in the nozzle in motion and helps prevent it from drying out. 



Dimatix Materials Printer User Manual 

FUJIFILM Dimatix, Inc. Confidential Information Page 31 of 93 DUM00001 Rev.09 Ver.1.3 09/06/06 

Replacing Cleaning Pad 
Located in the Tools pull down menu on the main screen is a feature called Replace 
Cleaning Pad. You will want to replace the cleaning pad with a new one when it gets 

filled with fluid or clogged by fluid residue and does not effectively blot the nozzle surface 

of the cartridge, or you are changing cartridge fluids and don’t want cross contamination 

from contacting the previous material on the cleaning pad.  

 

To replace the cleaning pad select Replace Cleaning Pad from the Tools menu. The 

cartridge will move to allow access to the pad. 

 

 
 

DO NOT open the printer lid until told to do so. Opening the lid while the printer is in 

motion will necessitate a re-initialization of the printer motors. 
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Open the lid and replace the pad. 

 

 
 

Replace the pad by: 

• Taking the top clear cap of a new Cleaning Pad assembly and push it down on the 

old pad until you hear a click and then simply pull it out. 
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• Insert the new pad and holder by pushing the pad and holder down into the spot 

where the old one was until you hear a click. 

 
*Be careful not to remove the cleaning pad by itself. This may damage the springs 

holding the receptacle which will then not position it correctly. 

When the lid is closed the carriage will move back to the cleaning station. 

Pattern Printing 
Note: If you are printing a pattern on a substrate that you will either remove and 

reposition, or change cartridges, be sure to set the Printing Origin before printing the first 

pattern.  

 
Select Pattern 
The following screen allows you to pick a print pattern file that has already been created, 

or to create a new one. 
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From the Select button in the Print Pattern box you saw earlier that there are several 

pre-defined standard pattern files.  

 

Pre-Defined Standard Patterns 

                                 
     Microscope         Line Array      1 mm Hatch  1 cm Solid Dimatix Test Pattern 

  Slide 25K array 
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Create Your Own Pattern 
The Pattern Editor allows you to create or modify pattern of drops for printing, and easily 

repeat it if desired onto a substrate. The basic pattern of drops at the lowest level (the 

Pattern Block Array table) is user-defined as a collection of rectangles. Each rectangle 

in the table may be small enough to represent a single drop, or thin enough to represent a 

line of drop, or large enough to represent a filled-in rectangular area. 

 

In all cases, X increases to the right, and Y increases toward the front of the printer. All 

dimension parameters are in millimeters except for the Drop Spacing, which is in 

microns. All dimensions entered into the pattern generator are rounded onto the Drop 
Spacing which is the spacing between drops to form a pattern feature. 

 

By selecting the Edit button on the Select Pattern screen the following screen appears: 
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Substrate 
The Dimensions is the total area that will be printed. Generally most people will jet on 

only a single substrate. But you could place several smaller substrates on the platen and 

jet on all of them at once. Verify that the total area is not larger than your substrate. 

 

The Leader Bar is a vertical bar that can be jetted (by checking the Enable box) which 

will precede your pattern. This is often used to “pre-fire” nozzles to keep them active and 

their drop velocity uniform to improve pattern quality. The Width of it and the Gap of the 

Leader Bar can be entered in the boxes. 

 

The Drop Spacing is the center to center distance from one drop to the next in X and Y 

position to create the pattern. This can be adjusted in 1 micron increments with a 

minimum of 5 microns. Usually a drop spacing around 20 microns gives good printing 

results. The X spacing is controlled by the x axis encoder, while the y axis is controlled by 

the cartridge angle. 

 

The Layers box feature allows you to reprint the same pattern over itself automatically. 

The Count number is the number of times you want to print the pattern and the 

Interlayer Delay is the delay time between each layer, additional to the amount of time 

spent doing any Before Print or After Print maintenance on the cartridge. 

 

If you click on the Preview Drops button a window will pop up showing the area you have 

designated. The total area of the window represents the platen. If the substrate area you 

entered is smaller than the platen it will show as a beige shape inside the white area.  
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Your Pattern Block Array area is delineated within the substrate area outlined. 

 
 
Pattern Block Array 
In the Pattern Block Array box enter the point on your substrate where you want the 

pattern to start printing in X and Y, referencing from the print origin. Then enter the X 

width and Y height of the block you want to make. The X and Y sizes entered should be 

at least large enough to enclose the collection of rectangles defined in the Pattern Block 
Drop Positions (see below). 

 

Note: The default print origin is approximately -1 mm, 7 mm (x,y) from the 0,0 corner 

scribed in the back left of the platen. 

 

To print a repetitive array of the pattern block in your print area, enter the X and Y Pitch 

dimensions. The Pitch is the distance from the start of one pattern to the next. Enter the 

number of repetitions (X count) to print in the horizontal direction, and the number of 

repetitions (Y count) to print in the vertical direction.  

 
 

ED
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Pattern Block Drop Position  

The pattern generator works with one or more user-entered rectangles of X width by Y 

height. When you enter the dimensions of your feature in the appropriate boxes and click 

the Add button, it will be placed in the table on the bottom of the window. 

 

Note: Only those rectangles that are added to the table on the bottom of the pattern 

editor window get saved once you are done creating your pattern. 

 

In the Pattern Block Drop Position box:  

• Enter the position (X and Y) where you want to place the first drop in your Pattern 

in the Pattern Block.  

• Then enter the Length and Height of the “feature” you want to create. For lines, 

enter the width height of the line that you want. For example, for a horizontal line 

you would enter how long you want it to be in the x direction (X, width), maybe 10 

mm, and for 200 microns “tall” you would enter 200 microns for the Y Height. For 

the same vertical line, it would be 200 micron X width, and 10mm Y height. To 

define a feature that is a single row of dots or a single dot, use a dimension or 

dimensions smaller than the Drop Spacing parameter 

• The Increment Value is the value at which you want the dimensions to change 

with each click of the arrow buttons. For example and Increment value of 1.000 will 

change the dimension 1 mm for every click of the arrow. The Increment vale gives 

you a convenient way to generate a set of related rectangles. 

* You can also very easily create a rectangle by placing the cursor on the Preview 
Drops window, place the cursor in a Block, hold the Shift key down and “point, 

click and drag” to create a rectangle. 

 

If you click on the Preview Drops button, a window will pop up which shows you the 

pattern. When you click on a line of data in the table specifying a feature, that feature will 

show up in red on the Preview Drops screen. You can Zoom In on the feature by 

clicking on the “+ magnifying glass button” to where you can see the individual spots. 

When you Zoom In it is best to have Show All Patterns de-selected to reduce data 

crunching. You can continue Zooming in until you see the grid background. Then when 

you hold the Ctrl button on the keyboard and point and drag the left mouse button on 
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your feature of interest you can zoom in and it will stay centered on the screen. You can 

also zoom in by hold down the Ctrl key on the key board, placing the cursor on your point 

of interest and clicking. This will zoom you to the individual drop and grid level. 

 
 

 
 

You will see grey lines on the screen which represent the pattern as you created it in the 

Pattern Generator. The dots are actually where the drops will be placed as the 

dimensions are round to fit on the grid you have defined in the Drop Spacing. 
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If you highlight a line in the table and click the Add button you will duplicate that feature. It 

will be jetted right on top of itself unless you change the x and y start points, which you 

can do by highlighting that data line in the Pattern Generator table and then changing the 

numbers in the appropriate boxes. 

 

The Preview Spot Size box let’s you enter the diameter of the spot that a single drop 

makes on your substrate. This is helpful to visualize how much separation or overlap of 

drops you have in the pattern features depending on their size and the Drop Spacing 

used. When reviewing the pattern to see how the features match the grid or how 

adjoining features line up set the Spot Size to 10 microns. 

 

The Enable Spot Size feature allows you to zoom in on the image and view the individual 

spots of your pattern. Putting a check in the box by clicking on it enables it. Click on it to 

disable it to view all of the patterns. 

 

The Show All Patterns feature enables you to see all the patterns on the substrate when 

checked. 

 

The 1x button feature displays you pattern on the screen to very close to its actual size. 

 

Drop Spacing 
The Drop Spacing is the distance in X and Y, center to center, of the drops that the DMP 

will deposit to create the pattern. Drop Spacing is adjustable between 5 and 254 microns 

in one micron increments. It will toggle with the arrows on the box in five micron 

increments.  For example, with a 50 micron Drop Spacing, the pattern generator will place 

drops 50 microns apart in X and 50 microns apart in Y to fill in your pattern. So, for a 100 

micron wide, 10 mm tall vertical line, the system will place 3 drops in the X direction (one 

for the first edge, another at 50 microns, and another at 100 microns for the next edge) by 

2,001 drops tall. The Drop Spacing therefore determines your resolution or density in the 

X direction and determines the angle at which the cartridge must be set to get the same 

resolution or density in the Y direction. The Drop Spacing parameter is most useful for 

altering the fill density (amount of jetted ink per unit area) of lines and rectangles, or it 
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may be used to create rows of individual drops which are spaced closer together than 

254 microns. When you create a pattern the dimensions and locations of the features 

should be divisible by the Drop Spacing for optimum placement matching. If not there 

may be some shift the features. 

 
Nozzle Test Pattern 
There is a 16 line test pattern which can be run to see the performance of each nozzle 

individually. This is done while on the Print Set-up window by holding down the control 

key on the key board and clicking on the Print button on the bottom right of the window. 

Set the cartridge to 90 degrees before running the pattern. 

BMP and Gerber File Printing: 
To import BMP files or Gerber files into the DMP Software, select Tools on the main 

screen. Then select Pattern Editor (Bitmap images). This will open the Image to 
Pattern Converter window. Then under File, select Open BMP or Open Gerber to open 

your file. *The Gerber Tools option must be loaded in the system for Gerber File 

conversion.  
 
Gerber Files 
To open a Gerber file, set the drop spacing you want the image printed to and then select 

‘Open Gerber’ from the File menu. Select the Gerber file you want.  

 

*The Gerber file will be processed into a BMP at the selected drop spacing resolution.  

All of the controls will operate as if it was a BMP file with the exception of drop spacing 

and X Width, Y Height. Since a Gerber file is resolution independent, changing the drop 

spacing does not change the dimensions of the output.  

 

*If you change the Drop Spacing you must then save the file for it to be processed at the 

new drop spacing. 
 

ED


ED
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The Substrate Tab has the following features: 

o Substrate Dimensions – this is the calculated minimum size of a substrate that 

will be needed to print the pattern 

o Leader Bar – This is the same as in the Pattern files. This is a vertical bar that 

you may add to your pattern to enhance printing quality.  

o Drop Spacing – the same as in Pattern Printing, this is the spacing of the drops 

(center to center) in x and y that will be jetted to create the pattern. The x spacing 

is encoder  controlled and the y spacing is set by the cartridge angle. 

o Layers – this is the same as in Pattern Printing and allows you to re-print the 

same pattern over itself several times (Count) with or without a delay (Interlayer 

delay). 
 

The ‘Full’, ‘Fit’, ‘Zoom’, and ‘Pan’ enable movement and zooming of the image. When 

an image is first loaded it will zoom to ‘Fit’. This shows the full extents of the bitmap. 
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Clicking the ‘Full’ button will zoom in on the image to the point where each pixel in the 

BMP file is displayed as a pixel on the screen. The form may be resized to provide a 

larger preview. 

 

If the Zoom button is selected, then clicking and dragging the left mouse button over the 

image will create a zoom window. When the mouse is released the image will zoom to the 

selected area. If ‘Pan’ is selected, clicking the left button and dragging in the image will 

move the viewable image in the window. These controls can be used to view the high 

resolution data and aid in selecting the reference point. 

 

Tiled Preview allows viewing of all the patterns to be printed. 
 

Placement / Tiling 
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Placement: 
 X Start, Y Start is the position relative to the Printing Origin that the pattern will start. 

 X Width, and Y Height is the calculated size of the pattern.  

 

Tiling: 
This is used to make multiple print copies of the same pattern. The Pitch is the distance 

from the beginning of one pattern to the next as set in X pitch and Y pitch. The number of 

patterns is set by the Count. 
 

Reference Point: 

 
 

The X Ref, Y Ref, ‘Locate Ref Point’, and ‘Set Ref Point’ provide an additional way to 

position the image by aligning a point in the image to a specific point on the substrate (a 

point is selected in the image and a corresponding point is selected in the Fiducial 

Camera form). 
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• To print using a Reference Point in your image, check the box “Use Reference 
Point”  

• To set a Reference Point, first locate the part of the image you wish to align to by 

either using Zoom or Pan. Click ‘Set Ref Point’. Then place the cursor on the 

point in the image. You can make fine adjustments by clicking the arrow up/down 

buttons next to the X Ref and Y Ref fields. If you know the dimensions for the 

Reference Point you can type them in directly into the X Ref, Y Ref boxes then 

click ‘Locate Ref Point’. This will take you to that specific point in the image. The 

cross hair cursor that displays the reference point will show when the pattern is 

printed.  

• To complete the Reference Point usage, go to the Fiducial Camera window (see 

Fiducial Camera section). Click on the Fiducial Camera button on the main Drop 

Manager window to open the Fiducial Camera. 

• In the Tools menu of the Fiducial Camera click on the “Set Reference Point” 

button. Click OK on the pop up window. 

• Find the point on your substrate where you want to place your selected image 

Reference Point by moving the camera to the desired position. Place and click the 

cursor on your point.  

• Click the “Use Reference Point” box on the Fiducial camera window.  

• Do not close the Fiducial camera window before you print. It must stay open. 

Simply click the Print button on the main Drop Manager “Print Set-Up” window. 
 

The X Width and Y Height values are filled in when a file is loaded. The size is based on 

the image size and the drop spacing. BMP files must be printed at the Drop Spacing 

(resolution or dpi) they were created for, or the image size will change accordingly.  

A status bar at the bottom shows the current Zoom Factor, the location of the upper left of 

the preview, and the Image Size. The current cursor position is also displayed.  

ED
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When all of the parameters are correct you must save the file as a pattern file (it has a .ptf 

extension). The pattern file is what can be selected from the main form or the fiducial form 

to print. 

 

Print Preview 
 
The Print Preview can be disabled or enabled in the Main Dimatix Drop Manager Form 

'File' menu. If it is on, it will show a preview before the printing starts. The Title Bar of the 

dialog tells if the reference or printing origin is being used. The origin (or reference 
point) is marked with a cross hair. The Leader Bar is shown if it is enabled. 

 

The preview is sizable so it can be made full screen for more detail. Remember, the 

platen area is not the substrate! The user has to make sure the substrate is placed 

correctly on the platen and that it will fit the image they are going to print. The preview is 

meant to make sure they have set the origin and tiling correctly. 
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The following are some sample screen shots using the Reference Point and Leader Bar 
on a tiled pattern. The Reference Image used in this example is the lower right one of the 

array and there is a Leader Bar: 

 
 

This example shows a Tiled array, using a Print Origin, without a Leader Bar: 
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Pattern with x/y start offset, tiling, using print origin (all patterns use the print origin): 

 
 

A tiled image with a bad reference point: 
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The error message you get if you try to print from an origin that takes the image off the 

printable platen area: 

 
 

Cartridge Mounting Angle 
Before you jet your pattern, the system will calculate the angle to set the cartridge 

determined by the Grid Spacing specified in the pattern. This angle adjustment is what 

allows the user to modify the drop spacing in the Y axis. 

 

The following is a top view of the carriage. There are two sets of scales. The outer scale 

is the cartridge angle scale, and the inner scale is the vernier scale to adjust the head 

angle to 0.1 degree increments. Release the latch by pulling it forward freeing the 

carriage plate to rotate. 

Latch 
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The following is a close-up of the cartridge angle alignment scale set to 0 degrees. The 

outer main scale is in one degree increments. There is a notch on the 0 point of the inner 

vernier scale is lined up with the 0 on the outer cartridge angle scale. 

 
 
The following picture shows how to set the cartridge angle to 11.4 degrees. The 0 notch 

on the inner vernier scale is a little past the 11 degree mark. The next inner mark on the 

vernier that is lined up with a mark on the outer ring is line 4. This gives 11.4 degrees. If 

you wanted to set the cartridge angle to 11.5 degrees, then you would move the inner 

ring a little more to get the 5th mark lined up with a mark on the outer ring. 
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Drop Watcher 
In the bottom left of the screen is the Drop Watcher button. Clicking on it will move the 

carriage to the right side of the platen, positioning the jetting cartridge’s nozzles over the 

Drop Watcher Camera system. This system allows direct viewing of the jetting nozzles, 

the faceplate surrounding the nozzles, and the actual jetting of the fluid. The Cartridge 

Settings window also comes up at this time to allow you to modify the drive waveform 

and view the changes in jetting characteristics. 

 

Note: Tickle control will be not active (displayed in gray) when you open the cartridge 

settings window via the Drop Watcher. In order to be able to change tickle control, open 

the cartridge settings window directly by clicking the edit button in the print setup tab in 

the DMP main program. 

  
Once the carriage and cartridge are in position, click on the Viewing Nozzle box – 

number 8 should in the box. When you click on it, the system will bring nozzle number 8 

of the cartridge into the center of the screen. You can then increment up or down to 

different nozzles and the system will move that nozzle into position in the screen. There is 

also a list of the nozzle numbers across the screen in which you can turn any of them on 

or off. By clicking the box associated with each nozzle it will fire that nozzle or turn it off. 

To minimize spraying off of the absorbent Drop Watch Pad, the user interface limits 

selecting jetting nozzles to the four surrounding the Viewing Nozzle. 

 

If you want to do a maintenance cycle to improve jetting, you can do that by clicking on 

the Run Now button on the Cleaning box. 
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There are also two arrow buttons near the bottom left of the screen, which allow you to 

focus the camera on the nozzles and drops by clicking repeatedly until the image is in 

focus. 

 

The drop watcher system provides you with two different viewing modes, selected under 

Viewing and Capture Control. 

• If you click on Movie Mode box, this allows you to watch a stroboscopic “movie” of 

drops in flight as they are ejected from the nozzle. This is real time continuous 

firing of the nozzles. Clicking this box also changes the Image Title and Capture 
Image to either Image or Movie. 

• If Movie Mode is not checked, then the drops appear to be frozen in flight for 

closer inspection and measurement. By adjusting the strobe delay you freeze the 

drop at different positions after it leaves the nozzle. 

• You can click on the various nozzles to see how they perform. 

• In Tools there are different versions of the video window’s Graticule or scale 

available. 
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• The Image/Movie Title button allows you to put a title at the bottom of the screen 

in the image after “Dimatix DMP2800” – Your Title Here. The nozzle number that 

you are viewing, the firing voltage, the cartridge temperature, the waveform file 

name, and the date and time are automatically stored on the image. 

• Under Tools, the Display Image Information allows you to turn on or off the 

image information. 

• The Capture Image/Movie button allows you to store a still image video of the 

jetting with all the conditions information on it. 

• When in Movie Mode the Configure Capture Quality button allows you to adjust 

the quality (and subsequently the file size) of the image by clicking on the Settings 

tab in the window that pops up. The dialog displayed will depend on the type of 

video interface installed in your system. A system with a Pinnacle Dazzle card 

(which is an external video device) will display the following:  
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If a PCI video capture card is installed internal to the PC, the following will 

appear: 

 
 

• The Drop Viewing Speed slider changes the sweep rate of the delay of the strobe 

while in Movie Mode. This has the effect of making the appearance of drop 

formation go faster or slower. 

• The Drop Refresh Rate slider adjust the time at which the sweep delay starts over 

thereby adjusting how long you see a drop in flight. 

 

The Firing Control box allows you to adjust the Firing Frequency while you are jetting 

to observe the effects by clicking on the slide the bar with your mouse and dragging it. 

The minimum frequency is 1 kHz. 

• The Strobe Delay lets you set the time after the drop fire pulse at which the strobe 

LED fires to capture the drop image. This can be adjusted with the slide bar also. 
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This has the effect of freezing the drop in flight. Clicking on the Delay 100 us 

button automatically sets the delay to 100 us after the fire pulse. When you set the 

nozzles on the 0 um line on the screen with the Graticle on you can measure drop 

velocity. For example, with a 100 usec strobe delay you are seeing the drop after it 

has traveled for 100 usec. If the drop is at the 500 um line then the drop’s velocity 

is 5 meters per second. This feature will come in handy when switching cartridges 

as you will want to match drop velocities by adjusting voltage to the nozzles to get 

consistent results. A good velocity to set is between 7 – 9 m/sec.  

 

The Tools tab for this screen lets you select different features. 

o Graticule – This places a scale on the screen for velocity and drop 

formation measurements. The choices are: None, Left, or Full. Click on the 

one you want to use. 

o Calibrate Nozzle View – This feature automatically controls the stage 

motion to keep the nozzles in line when drop watching regardless of the 

cartridge angle. To perform this operation follow the following procedure: 
- Start by clicking on Calibrate Nozzle View. 
- The screen image should be close to nozzle 1. Find nozzle 1 (the 

rightmost orifice), put mouse pointer on the nozzle and click-drag it to 

the cross-hair on the screen. Use the focus buttons as necessary to 

refine the nozzle’s focus. 
- Click the Next button and drag the image to the right until nozzle 16 

(the leftmost nozzle) is under the cross hair. Use the focus buttons 

again as necessary to refine the nozzle’s focus. 
- Click Next again and you are done calibrating the nozzle view. Now, 

when you select any nozzle from one to sixteen, the selected nozzle 

should be close to the 0 line opening, and in focus. 
- For the stage to move the selected nozzle into position you must 

index through the nozzles using the Viewing Nozzle box. When you 

open the drop watcher it will try to center nozzle #8 in the middle of 

the screen and put nozzle 8 in the Viewing Nozzle box. By clicking 

the cursor in the box it turn the nozzle on and move it up to the 0 line. 
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o View Cartridge settings – this allows you to open the cartridge settings 

form if they were closed. 

o Drop Volume Measurement - this is a procedure that will allow you to 

measure drop volume by using an average drop weight technique. 

The flowing screen shots show the procedure as it appears on the system 

when you are running it. You begin by opening the Drop Watcher window: 

 

 
 

The following note explains to wait until the carriage moves into position and stops. A 

general note to remember he is that the DMP lid is the safety interlock. Opening the lid 

during any system motion will cause the system to re-initialize the motors. 
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When the carriage moves over into position it is about 25mm above the platen surface. 
 

 

 

To begin with you need a container that you have weighed and that will fit under the 

carriage. It is best to use one that is shallow that the carriage can be lowered close to the 

bottom of it (to prevent drop lose from floating away). 
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Adjust the carriage as close as you can to the bottom of the container. This will yield more 

accurate results. 

 
 

You want to weigh as many drops as practical to get a more accurate number. The 

number of nozzles you have selected to fire in the drop watcher before opening this menu 

will show up on the form. The frequency you set it the Drop Watcher will be the firing 

frequency for this procedure. The following form shows 7 nozzles have been selected. 

The default time period will be calculated based on the frequency and number of jets to 

get close to 1 million drops. Adjust the time to change the number of drops jetted. 
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Once it finishes jetting you are ready to calculate the drop mass after weighing the pan. 

 

 

Drop Watcher Pad 

The Drop Watcher Pad is located in the center of the Drop Watcher mechanism 

and acts as the receptacle for fluid during jetting. It will need to be changed 

periodically as it absorbs fluid. Typically this occurs when you see stray drops 

being deposited on the nozzle surface during drop watching or fluid is covering the 

side of the Pad holder. To replace the pad simply pull out the holder and insert a 

new one. 
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Fiducial Camera 
On the main Dimatix Drop Manager window go into the Tools menu and select Fiducial 
Functions or click on the Fiducial Camera button.  

 

 

 

The above image is a sample screen shot of the main Fiducial Camera window. The 

fiducial camera feature is used when you want to deposit a pattern on a pre-patterned 

substrate, patterned on the DMP but removed, or that you are jetting a pattern with a 

different material (cartridge) than with which the first pattern was created, or to view the 

printed features. 

 

The information just above the image is about the Camera Field of View. This currently 

is a width of 1.62 mm and a height of 1.22 mm with a resolution of 2.54 microns per pixel. 
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Features 

• Light Intensity – This slider allows you to adjust the light intensity of the camera 

to optimize the contrast of the image. 

• X-Track Speed – With this slider button you can adjust the movement speed of 

the stage in the x axis when aligning and making measurements. This adjustment 

is done by placing the mouse curser on the slide and dragging it to the desired 

speed. 

• Y-Track Speed – With this slider button you can adjust the movement speed of 

the stage in the y-axis when aligning and making measurements. This adjustment 

is done by placing the mouse curser on the slide and dragging it to the desired 

speed. 

• Focus – These two arrows allow you to focus the camera up or down. The number 

in the bottom of the Focus box is the height in mm from the last set focus origin 

that the camera is currently focused to. This feature allows you to make Z height 

measurements if you want to. The focused Z height is about 32mm above the 

substrate. When using the fiducial camera you can only print on a maximum 
substrate thickness of a 25 mm. 

• Y-, Y+, X-, X+ – These buttons allow you to move the carriage to any position 

simply by clicking on the button corresponding to the direction you want to go. 

• Center X- Position, Center Y-Position – This is the position in mm of the center 

of the crosshair displayed on the screen relative to the last set Print Origin.  

• Move Controls 

o Platen – The “yellow area” is the area where the camera can view a 

feature. The “green area” is where you can set a Print Origin point. The 

red cross-hair in the platen box window displays the position of the current 
Print Origin. The red box in the window shows where you are currently 

viewing on the platen and the grey box indicates the position of the 

coordinates that are in the X-Position and Y-Position boxes. If there is a 

green box that shows you the position of the image Reference Point you 

have selected. 

o X-Position, Y-Position – These boxes have two ways to operate. You can 

either enter a number into the boxes and then click the Move button and the 

camera will move to that position, or place the curser in the green area of 
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the Platen box and click on a location and then click the Move button and 

the camera will move to that point and its coordinates will be displayed in 

the boxes. 

o Home – Clicking on this button moves the camera back to the Print Origin. 

• Cursor X-Position, Cursor Y- Position – This box tells you the position of the 

cursor relative to the print origin in either the displayed image or in the Platen box. 

• Image Reference Point – The position of the Reference Point you have selected 

relative to the selected Print Origin.  This is the physical point on the substrate 

that you want to align a BMP or Gerber file to for printing. This is only used for 

BMP and Gerber images and not Dimatix Pattern generated files. See BMP 

printing for more information. 

o Use Reference Point – By checking this box the DMP will position the 

pattern’s reference point to the Image Reference Point. It will do this 

only with the Fiducial Camera window open. If you do not use the 

reference point the image will be printed from the print origin. 

• Viewing and Capture Control – This box allows you to configure the video device 

and capture the displayed image similar to the Drop Watcher Image capture 

feature.  

� Configure – The configuration should be as shown in the 

window below. The “Dazzle” device should be selected if your 

system was delivered with one, or the Hauppauge Card 

should be selected if your system was delivered with an 

internal video card 
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� Image Title – Click on this to open the box as seen below to 

type in a name for your image. 

 
� Capture Image – Click on this to save the image in a file of 

your designation. 

 

o Data Point History – This box allows you to select any points in your 

pattern and save them in a file for future reference or for analysis in an 

Excel spreadsheet. Simply place the cursor on the point you wish to capture 

and click on it. The x & y position will go into the table. If you click on the 

line of data in the table you can then enter a description of that point if you 

desire. By clicking on the Show Data Points or Show Description boxes 

you can turn those on or off. 
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Alignment Procedures 
When you first click on Fiducial Functions from the Tools menu on the DDM window the 

camera goes to the last Print Origin. The Center X-Position and Center Y-Position 

boxes will show you where the crosshair is relative to the origin. If it is slightly off you can 

click on Home, and it will move closer to the origin point.  

 

Tools Menu in the Fiducial Camera Window  

• Set Print Origin – This feature is to set the origin of your pattern.  

o When you click on the Set Print Origin the following window pops up. 

 

 
 

o With the Fiducial camera open, move the camera to the point you want to 

be the origin. Place the cursor on the image and click on the point you want 

for the origin. That will be the origin from which other measurements will be 

made and from which the pattern you choose to print will originate from. 

When you click on your point, the crosshairs and camera will center on that 

point. You cannot set an origin on the lines scribed in the platen. The 

location which will allow you the largest printing area is about 7mm down 
from the X line and about 4mm to the left of the Y line. 

 

• Set Focus Origin –Use the arrow buttons to focus up or down and then click on 

this feature in the Tools menu.  

• Set Reference Point – This is used to set the physical reference point for an 

Image Reference Point you may have selected. The image will be aligned so that 

its reference point is printed at this location on your substrate.  
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o When you click on the Set Reference Point the following window pops up. 

 
 

 

o Similar to setting a Printing Origin, move to the position on the substrate you 

wish to use, then place the cursor on that point on the view image and right 

click. The up/down arrow buttons on the reference point’s X-Position and Y-

Position boxes can be used to adjust the point. 

o You must check the “Use Reference Point” box on the Fiducial Camera 

window, and you must leave the camera window open to print the image 

using the Reference Point feature. (Refer to BMP and Gerber File Printing 

for more info). 

• Set Drop Offset – This feature is used to calibrate the position of a new or 

different cartridge to the previous printed pattern. *This procedure is very 
important and must be done when trying to precisely match patterns or 
place drops in precise locations. 

o In an area outside your printing area of concern, you will jet a pattern where 

you can locate one drop. The pattern will be printed with the nozzles you 

have selected in the Cartridge settings you are using and consists of a line 

with a single dot after it. 

o When you click on Set Drop Offset in the Tools menu the following window 

pops up. 

o To start you must have the cartridge set to the angle required by your 

pattern.  
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Move to position where you can print the test pattern and place the cursor on the 

screen and click to select the start location. 
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After the test pattern is printed locate the single spot with the Fiducial camera and 

find and click on it. 

 
 

It should look something like the following image: 
 

 
 

 

 



Dimatix Materials Printer User Manual 

FUJIFILM Dimatix, Inc. Confidential Information Page 69 of 93 DUM00001 Rev.09 Ver.1.3 09/06/06 

This routine is now completed:  
 

 

 

If the Drop Offset is determined to be outside the normal range it will need 

to be repeated after verifying that the first nozzle selected in the cartridge 

settings is firing properly and that the cartridge is positioned well in the 

holder. 
 

 
 

This has now adjusted any positional offset from the newly installed cartridge to 

Fiducial camera which you set the Origins and Reference Points with. 

 

• Set Drop Offset (Manual) – This is used to calibrate a new or different cartridge 

by creating your own pattern. This may be useful when jesting clear or difficult to 

see fluids.  

o In an area outside your printing area of concern, jet a pattern where you can 

locate one drop. This can be a single drop pattern (which may be difficult to 
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find or see) or maybe a square of 5 drops (x&y) or a  

“+” pattern  that you can find with the camera. 

o When you click on Set Drop Offset in the Tools menu the following window 

pops up: 

 
o Enter the position of the dot you specified as the upper left dot in your 

Pattern Generator file. 

o Click on the Set Drop Offset button and the following window pops up: 

 
o Click OK. 

o Then place the cursor on the center of the drop in the pattern that you just 

jetted and click. 

o This has now adjusted any positional offset from the cartridge to what the 

pattern file specifies. 

 

• Calibrate Theta – This feature allows you to compensate for an angular offset that 

you might have on the substrate or pattern that you have placed on the platen. To 

calibrate: 

o Click on the feature in the Tools menu and the following window pops up: 
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o Follow the instructions and click on the Set Start Pos button and the 

following window pops up: 

 
o Click on the first point you want to use on the fiducial camera image. The 

following screen then pops up: 

 
o Move to the next spot you want to use for Theta calibration by using the X+, 

X-, Y+, or Y- buttons on the Fiducial Camera window. If you are using a 

point far from your current position you may also jump there by pointing to it 

in the “green” area of the Platen in the Move Controls box on the Fiducial 
Camera window and clicking the Move button. You may also enter the 

coordinates in the Move Controls box and click move. 

o After clicking on the second point the following window pops up. Click OK or 

Cancel. 



Dimatix Materials Printer User Manual 

FUJIFILM Dimatix, Inc. Confidential Information Page 72 of 93 DUM00001 Rev.09 Ver.1.3 09/06/06 

 
 

• Calibrate Thermal Scaling – This feature allows you to compensate for a 

substrate that has changed dimensions during a thermal process after printing, 

and you want to print on it again, or that changes dimensions significantly if heated 

while on the platen. 

 
 

o To start the thermal scaling process you start by entering the 

distance between your two fiducial marks on your substrate that you 

are going to use for the calibration. 
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o Locate your first mark with the fiducial camera by moving it into 

position over the mark. 
o Click on the Start X (or Y if you have only Y direction marks) 

Measurement. The button will turn green and say Cancel if you want 

to cancel and start over. 
 

 
 

o With the Automove box checked the fiducial camera will 

automatically move in the direction you are calibrating the 

distance entered in the box.  
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o When the camera stops at the indicated position, place the cursor 

the second mark and left click the mouse. If you don’t see the 

feature in the image area move the camera with the x & y motion 

controls to locate it. 
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o Now you will want to repeat the procedure for the other axis (Y 

or X) if you have marks for that axis also. 

 
 

o When you have completed the calibration click the save button 

and you will now be ready to jet your pattern that will be 

corrected to the new size of your substrate. 
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• Measure Cartridge Angle – This feature is used in conjunction with the Print 
Cartridge Angle Pattern in the Fiducial Functions File menu. Occasionally you 

may experience gaps in your printed image. This may be a result of not setting the 

cartridge angle precisely enough and it may need adjusting. This is the procedure 

to tell you how much you are off and which way to correct it. Follow the instructions 

in each window. 
o In the Fiducial Camera window file menu select Print Cartridge Angle 

Pattern. A pattern with horizontal lines will be printed. Find the pattern by 

moving the camera with the X, Y Motion Controls to that location. Follow the 

instruction in the window to calibrate the cartridge. 
o Once the pattern is printed select Measure Cartridge Angle in the Tools 

menu of the Fiducial Camera window. Follow the instructions in the window. 
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An important note is that Nozzle 1 and 16 must be firing properly to achieve accurate 

results and that the cartridge angle must be set to the angle for your pattern. 

 

 

 

Move to a space where you can print he pattern or place a different substrate on the 

platen and place the cursor on the starting point on the screen and click on it. The system 

will then print the test pattern. 
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With the x,y motion controls, place the cross hairs on the center of the top line, click the 

next box, move to the bottom line, center the cross hairs on it and click the next box. 

 

 
 

The following window is an example of the results from measuring the jet angle. It tells 

you the direction and how much to adjust the head to get better printing.  
 

 

 
 Click Finish when you are done. 

 
Options menu in the Fiducial Camera Window 

• Measurement Mode – Clicking on this allows you to make measurements of 

features or between features on your substrate. When you click on Measurement 
Mode, you simply click on one point and then the other and the distance between 

them will be displayed on the image. 

• Crosshairs – This feature allow you to turn on or off the crosshairs displayed on 

the screen. 

• Text – This allows you to add text to the image. 
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File menu in the Fiducial Camera window 

• Print Pattern – This feature allows you to print the pattern selected on the main 

Drop Manager Window while in the fiducial mode. 

• Print Jet Angle Pattern – By clicking this item a pattern of two rows of dots will be 

printed to be used in the Measure Jet Angle feature in the Tools menu. It prints the 

pattern at a location about 1mm in X and 4 mm in Y from the origin. You want to 

the pattern selected on the main Drop Manager Window form when this is run. 

• Exit – Clicking on this allows you to exit the Fiducial Camera window. 
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Fluid Requirements 
Some of the fluid physical characteristics to achieve optimum performance are: 

• Viscosity –  10-12 centipoise at jetting temperature 

• Surface Tension – 28-33 dynes at jetting temperature 

• Low Volatility – Boiling points higher than 100 deg. C are preferred 

• Density – Specific gravity greater than 1 is beneficial 

• Degassing – Additionally the fluid may need to be degassed to remove any 

dissolved gas which inhibits jetting. Typical degassing can be done with a vacuum 

(a negative pressure of 2 psi for 1-2 hours maybe sufficient or up to only 50mbar), 

by using ultrasonic, or by spinning (fully miscible solutions only).  

Refer to Dimatix Application Notes at www.dimatix.com for more information. 

 
Dimatix Model Fluid MFL-002 
This fluid is a non-toxic, non-hazardous, non-drying fluid used in our testing and qualify 

printheads and jetting assemblies. 

• The surface tension is 33 (+/- 3.5 dynes/cm) at jetting temperature. A polymeric 

dye was selected to color the fluid. 

• The jetting temperature for Model Fluid 2 is 30°C, resulting in a typical viscosity of 

11 centipoise. 
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Drop Formation 

  
 

The following screen is a typical single pulse waveform such as one used for the Dimatix 

Model Fluid: 

 
 

 
- Refer to application note for tuning of various fluids 
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The following are typical jetting results that the user may see from jettable fluids. 

 
Drop Velocity vs. Frequency 
Here you will see that higher viscosity fluids will have lower velocity and a better high 

frequency performance due to their dampening effect. Higher voltages to the cartridge are 

required for higher viscosities. 
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Drop Velocity vs. Voltage with different Viscosities 
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Voltage vs. Drop Mass 
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On the following picture you see a captured frame of a video taken during the testing of 

Dimatix Model Fluid. You can see that after the drop leaves the nozzle it has a tail. The 

liquid on this small scale is mostly influenced by cohesive forces within the fluid. Here not 

all of the tail collects into the main drop again. But you get a small drop of ink following 

the main drop. Switching to lower voltage leads to less tail. You could reduce the 

frequency, change the waveform, or a combination of these to get your desired drop 

formation. These drops were fired with 25V. 
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Cartridge 
 
Note: When opening the sealed bag that the Fluid Module and Jetting Module come in 

take care to prevent particles from getting in the fluid ports. 

 

 
 

 
 

*  Do not remove the film around the Nozzles. It will damage the cartridge. 
** Do not fill the Pressure Port with fluid. It will damage the printer. 
*** Do not get fluid on the Electrical Connector. It may cause electrical 

shorting. 
 

Fluid Module Filling 
Fill Syringe  

• Pull fluid into syringe (1.5 mL) 

 
• Install filter onto syringe. If the fluid is known to be filtered properly and not have 

agglomerates, you may not need to use a filter. Dimatix Model fluid does not a 

filter. 

 

Pressure Port 

 Fluid Bag 

Electrical Connector 
Nozzles 

Fill Port 

Jetting Module 

Fluid Case 

Fluid Module 
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• Slip a fill needle on the filter of syringe 

 
• Unscrew and remove the Fluid Module fill port cap 

• Carefully insert  the needle into Center Fill Port trying not to scrape the sides 

• Slowly push the syringe plunger into fill the Fluid Module.  

 
• Remove syringe 

 

Assembly 
Attach Fluid Module to Jetting Module 

• Remove a Jetting Module from its sealed pouch. 

• Align the Pressure Supply Port of the Fluid Module with the opening in the Jetting 

Module. 
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• Push the two halves straight together until the SECOND snap is felt and heard. 

This is a fairly rigid connection and takes a fair amount of force. 

 
• Once the two pieces are snapped together the fluid can flow into the jetting device 

of the cartridge. * Let the cartridge set for 30 minutes with the nozzles facing down. 

At this point care must be taken to protect the nozzles of the cartridge. If the fluid is 

very low surface tension it may flow out of the nozzles. If it is highly volatile it may 

start drying at the nozzle leaving residue and thereby preventing it from jetting. It is 

best to immediately place the filled cartridge in the DMP. 

 

 
 
 
 
 

Cartridge Maintenance 
The DMP contains hardware and software to perform one or more maintenance activities 

which are designed to initialize and maintain optimal jetting performance. 

• The Cleaning Station contains an absorbent pad to draw ink off of the nozzle plate 

when it is brought close to it. It does not actually touch the nozzle surface but 

rather it contacts the face plate around the nozzle plate. The pad is replaceable. 

• The Cleaning Station uses air pressure to pressurize the outside of the ink bag, 

which forces ink out through the nozzles. This is mainly used to initially prime the 

cartridge, but also as a method for reviving problem nozzles. The DMP includes a 

pump for this function, which is also used for meniscus control. 

Specific functions include: 

• “Purging” process pressurizes the cartridge to push fluid out the nozzles to 

remove trapped air to prime or clear the nozzles. 

 

Do not dispose this product as unsorted municipal waste. Collection 
of such waste separately for special treatment is necessary.   
(Entsorgen sie dieses Produkt nicht als unsortierten Hausmüll. Eine 
Fachgerechte Entsorgung ist nötig.) 

. 
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• “Spitting” is firing the nozzles at a selected frequency and duration. Tickle mode 

sends a non-firing pulse to the nozzles keeping the ink in motion at the nozzle 

plate to help keep it ready to fire. 

• “Blotting” is when the cartridge lowers to the Cleaning Pad so that the pad can 

adsorb excess fluid from the nozzle plate. 

• Meniscus Control is a low level vacuum applied to the ink reservoir to prevent ink 

from flowing out of the cartridge nozzles. 
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Cleaning Function Definitions 
Maintenance

Function
Definition Benefits Comments

Purging Applies air pressure to outside of 
fluid bag to force fluid through 
entire fluid path and out all 
nozzles at once.

Required for initial use to force 
air out of fluid path (prime).  
Clear severely clogged nozzles.  
Can also be used to lower 
printhead temperature by purging 
hot fluid and bringing system 
temperature fluid into the flow 
path.

Produces high flow rate of fluid, 
so purge time should be 
minimized for 1 ml cartridges.  
Used as last resort for clearing 
clogged nozzles.

Spitting Ejecting a predetermined 
number of drops at a 
predetermined frequency from 
one or more nozzles.

Clears the nozzles, brings fresh 
fluid to the pumping chamber 
and nozzles, keeps fluid path 
surfaces wet.  

Consumes ink that cannot be 
used for printing.  Typically used 
on a periodic basis, e.g. every X 
printing passes or every Y 
seconds, to maintain robust 
jetting performance.

Blotting Bringing an absorbent and/or 
wicking medium in close 
proximity to nozzle plate (may 
lightly touch) to remove excess 
fluid from the nozzle plate.  No 
wiping action.

Fluid puddling around nozzles 
can partially attach to ejected 
drops causing misdirected firing.  
In extreme cases, puddled fluid 
will flood the nozzle and prevent 
firing altogether.  In addition, 
excess fluid on the nozzle can 
fall or be flung off onto substrate 
or printer components.

Risk of cross contamination 
when switching cartridges of 
diffeent fluid if the Cleaning Pad 
is not changed.  

Tickle Mode Exercising the pumping chamber 
at low amplitude to rhythmically 
pulsate the nozzle exit meniscus.

Retards "skinning over" of nozzle 
exit meniscus.  Keeps nozzle exit 
wet.  

May be sufficient to keep nozzles 
"alive" for lower volatility fluids as 
an alternative to spitting.  Used 
while head is capped, or for low 
use nozzles during printing.
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Failure Modes, Prevention and Recovery 
Failure Mode Symptoms Prevention Recovery

1 Volatile solvents evaporate 
(dry) when printhead is not 
being used.  fluid viscosity 
increases, fluid dries inside of 
nozzles, crusts on nozzle 
plate surface.

When printing starts again, 
nozzles won't fire, or fire 
poorly (low velocity, 
misdirected).

Cap printhead when not 
printing. Spit into cap to 
saturate air with solvent 
vapors.  Spit occasionally 
and/or use tickle mode to 
keep nozzles alive.

Spit or purge, following by 
blot or wipe.  Replace 
cartridge if severe.

2 Volatile solvents evaporate 
(fluid dries) in nozzles that 
are not being used.  fluid 
viscosity increases, fluid 
dries inside of nozzles, crusts 
on nozzle plate surface.

When printing starts again, 
nozzles won't fire or fire 
poorly (low velocity, 
misdirected).

Exercise unused nozzles 
using tickle mode, and/or by 
spitting occasionally.

Spit or purge, following by 
blot or wipe.  Replace 
cartridge if severe.

3 In newly filled cartridges 
there is air in the fluid path. 

All nozzles fail to fire. none Purge the head to force air 
out of fluid path and fill 
pumping chamber and 
nozzles with fluid.  Follow 
with blot or wipe to remove 
excess fluid from nozzle 
plate.

4 Air becomes ingested in the 
nozzle due to excessive drop 
ejection dynamics. 

Some or all nozzles won't 
fire.

Adjust drive waveforms 
and/or fluid properties.

Purge the head to force air 
out of fluid path and fill 
pumping chamber and 
nozzles with fluid.  Follow 
with blot to remove excess 
fluid from nozzle plate.

5 Fluid oozes out of the 
nozzles due to gravity and 
capilary action.

Fluid collects on the face 
plate (see next item below)

Increase meniscus control 
vacuum level.

Blot the nozzle plate.

6 Drops and/or puddles of fluid 
collect on the nozzle plate 
and hang down.

Excess fluid temporarily 
attaches to drops as they are 
being ejected causing 
misdirection and/or low 
velocity.  Nozzles are flooded 
and will not eject drops at all.  
fluid falls onto substrate or 
printer, or is flung off by 
carriage motion.

Adjust drive waveforms to 
create more crisp drop 
ejection.  Blot or wipe surface 
periodically during printing.  
Increase meniscus control 
vacuum level.

Blot the nozzle plate.

7 Pumping force is not enough 
to overcome meniscus 
control vacuum

Some or all nozzles won't 
fire.

Decrease meniscus control 
vacuum level.

Decrease meniscus control 
vacuum level.
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System Faults 
There are several error messages that may occur during operation of the DMP. In these 

cases you will usually get a message to power off the DMP and then power it back on. If 

the problem is not remedied by turning the DMP off (leave off for 5 seconds minimum) 

and then back on, the system will have to be returned to FUJIFILM Dimatix for service. 

 

Faults 

• "The cartridge drive amplifier has malfunctioned." 

This is an error in the Amplifier calibration. Try replacing the jet cartridge. 

• "The platen heater is malfunctioning." 

This is a result of the platen heater having a short or an open. 

• "A motor has malfunctioned" 

One of several motors has detected an error. Check for material blocking the 

platen or carriage movement. 

• “Driver error” 

• “Encoder index” 

• “Home sensor” 

• “Movement error” 

• "The printer's 3 volt power supply has malfunctioned.” 

• “The printer's 5 volt power supply has malfunctioned." 

• "The purge pressure is too low." 

• "The cartridge meniscus vacuum can't be controlled." 

•  "The printer's internal memory has failed." 

• “The printer CPU firmware upgrade has failed."  

In this case the system will ask you to “Try Again.” 

• "The printer FPGA upgrade has failed.”  

In this case the system will ask you to “Try Again.” 

•  "An undefined printer error has occurred."  

 



Dimatix Materials Printer User Manual 

FUJIFILM Dimatix, Inc. Confidential Information Page 92 of 93 DUM00001 Rev.09 Ver.1.3 09/06/06 

Preventative Maintenance 
Carriage 
When installing cartridges, inspect the connector on the carriage holder. If you see any 

fluid on the connector, wipe it off with a clean lint free cloth or other similar material. 

Additionally, wipe any other fluid or debris from the holder area. 

 

Inspect the pressure seal area on the cartridge holder also. Make sure it is free of debris 

to ensure that proper pressure regulation can occur. 

 

Specifications 
System Description 

o Flat substrate, xyz stage, “ink jet” deposition system 
o Low cost, user-fillable piezo-based ink jet print cartridges  
o Built-in drop jetting observation system 
o Variable jetting resolution and pattern creation PC-controlled with Graphical User 

Interface (GUI) 
o Capable of jetting a wide range of fluids 
o Heated vacuum platen 
o Cartridge cleaning station 
o Includes PC, monitor, and software 

 

Mechanical System 

o Printable area 
- Substrate size < 0.5 mm thickness: 210 mm x 315 mm (8.27 in x 12.4 in) 
- Substrate size 0.5 - 25 mm thickness: 210 mm x 260 mm (8.27 in x 10.2 in) 

o Repeatability: ± 25 µm (± 0.001 in) 
o Substrate holder 

- Vacuum platen    
- Temperature adjustable ambient to 60° C 

o System footprint: 673 mm x 584 mm x 419 mm (26 in x 23 in x 16 in)  
o Weight approximately 43 kg (95 lbs) 
o Power 100-120 / 200-240 VAC 50/60Hz 375W maximum 

- Fuse @ 250 V 2A SLO-BLO 5 x 20 mm 
- Fuse @ 110 V 4A SLO-BLO 5 x 20 mm 

o Operating range 15-40° C at 5-80% RH non-condensing 
o Altitude up to 2000 m 
o Safety and EMC compliance 

- Safety: NRTL Certified to EN 61010-1, UL 61010-1, CSA 22.2 No. 61010-1 
- EMC: EN61326-1 Class A, FCC Part 15 Class A 
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Cartridge 

o Type: Piezo-driven jetting device with integrated 
reservoir and heater  

o Usable Ink Capacity:  Up to 1.5 ml (user-fillable) 
o Materials Compatibility:  Many water-based, solvent, acidic or basic fluids 
o Number of Nozzles:   16 nozzles, 254 µm spacing, single row 
o Drop Volume:   10 picoliter nominal 

 

Control PC and GUI 

o Pre-loaded patterned templates  
o Pattern preview 
o Editors: Pattern, piezo-driven waveform, cleaning cycle, substrate setting 

 

Replaceable Items 

o Print cartridge with one-time user-fillable reservoir 
o Cleaning station nozzle blotting pad 
o Drop watcher fluid absorbing pad 

 

Options 

o Fiducial alignment camera plus theta platen 
o Gerber file import software 

 

Warranty 
System must be returned to FUJIFILM Dimatix for service in approved shipping container 

(original crate). Shipping will be paid by FUJIFILM Dimatix if during the warranty period. If 

system has been altered, modified or misused the warranty will be null and void.  

 

Reference Information 
Please visit the FUJIFILM Dimatix Web site at www.dimatix.com for the latest application 

and ink jet usage information in the deposition field. 
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